


ระบบเครอืข่ายคอมพิวเตอรแ์ละอุปกรณเ์ครอืข่าย 

 

 



 เครอืขา่ยคอมพิวเตอรค์อือะไร 

 การเชือ่มโยงเครือ่งคอมพิวเตอรเ์พ่ือใชใ้นการโอนถา่ยขอ้มูลและสามารถสื่อสารระหวา่งกนัได ้

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 อนิเตอรเ์น็ต 

 อินเตอร์เน็ตเครือข่ายคอมพิวเตอร์ขนาดใหญ่ ท่ีเป็นแหล่งรวบรวมขอ้มูลในดา้นต่างๆ และ
มีการใหบ้ริการในหลายรูปแบบ เช่น ไปรษณียอิ์เลค็โทรนิค (E-mail), การสนทนาทาง
เครือข่าย (MSN, ICQ), เวบ็, การโอนถ่ายแฟ้มขอ้มูล (FTP), การเล่นเกมส์ออนไลน์ 
(Ragnarok) , การเขา้ชมเวบ็ไซต ์(Web) 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 ค าศพัทท์ีค่วรรูเ้ก่ียวกบัระบบเครอืขา่ย 

 Bit (บิต) หน่วยทางไฟฟ้า มีคา่เทา่กบั 0 หรือ 1 
 Bandwidth (แบนดว์ทิช)์ คอื ความเร็วในการสง่ขอ้มูลผา่นระบบเครือขา่ย มีหน่วยเป็น bps (บิต

ตอ่วนิาท)ี 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 Router 
 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

• ใช้ในการเช่ือมต่อระบบเครือข่ายทีม่ี
การเช่ือมต่อภายในแตกต่างกนั หรือ
เช่ือมระหว่าง LAN และ WAN 



 Switch 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

• ใช้ในการเช่ือมต่อกบัเคร่ืองคอมพวิเตอร์เข้า
เป็นระบบเครือข่ายเดยีวกนั หรือต่างกนักไ็ด้ 
• Bandwidth 10/100/1000 Mbps 

• แต่ละพอร์ตไม่มกีารใช้งานร่วมกนั 



 Hub 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

• ใช้ในการเช่ือมต่อกบัเคร่ืองคอมพวิเตอร์ให้
เป็นระบบเครือข่ายเดยีวกนั 
• Bandwidth 10/100/1000 Mbps 

• แต่ละพอร์ตใช้งานร่วมกนั(เช่ือมกนัหมด)  



 ความแตกตา่งระหวา่ง Hub และ Switch 

 Hub จะสง่ขอ้มูลทีเ่ขา้มาไปยงัทุกๆ พอรต์ของ Hub ยกเวน้พอรต์ทีข่อ้มูลดงักลา่วเขา้มายงั Hub 
ในขณะที ่Switch จะท าการเรยีนรูอุ้ปกรณท์ี่ตอ่กบัพอรต์ตา่งๆ ท าให ้Switch สง่ขอ้มูลไปยงัพอรต์ทีมี่
เครือ่งปลายทางอยูเ่ทา่นัน้ ไมส่ง่ไปทุกๆ พอรต์เหมือนกบั Hub ซึง่สง่ผลใหป้รมิาณขอ้มูลภายในระบบ
เครือขา่ยไม่มากเกินความจ าเป็น 

 Hub เป็นเพียงตวัขยายสญัญาณขอ้มูล (Repeater) เทา่นัน้ ในขณะที ่Switch จะมีการท างานทีซ่บัซอ้น
กวา่, มีการเรยีนรูอุ้ปกรณท์ีเ่ชือ่มตอ่, การตดัสนิใจสง่ขอ้มูลออกไปพอรต์ใด 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 Ethernet Card 

 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

• ติดตั้งบนเคร่ืองคอมพวิเตอร์เพือ่ให้
สามารถเช่ือมต่อเข้ากบัระบบเครือข่ายผ่าน
ทาง Switch หรือ Hub 

• Bandwidth 10/100/1000 Mbps 

 



 ไฟสถานะของEthernet Card 

 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 ไฟสถานะของEthernet Card 
 LINK ถา้สวา่งแสดงวา่ มีการเสยีบสายแลนเขา้

กบัการด์ และสามารถใชง้านได ้

 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

 10 ถา้สวา่งแสดงวา่ อุปกรณ์น้ีเช่ือมต่อดว้ยความเร็ว 10 MB/s เช่นเดียวกบัไฟ 
100 ถา้สวา่งแสดงวา่เช่ือมดว้ยความเร็ว 100 MB/s 

 ACT (Activity) ถา้กระพริบแสดงวา่มีการส่งขอ้มูลเขา้-ออกการ์ด 
(เน่ืองมาจากกิจกรรมการใชเ้ครือข่ายต่างๆ เช่น การใชอิ้นเตอร์เน็ต, การแชร์
ไฟล ์ฯลฯ ถา้มีการส่งขอ้มูลจ านวนมากจะเปล่ียนจากกระพริบมาเป็นสวา่ง
คา้งตลอดเวลา 



 Modem 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

Internal Modem 

External Modem 

• ใช้ในการเช่ือมต่อระบบเครือข่ายผ่านทาง
สายโทรศัพท์ 
• Bandwidth 56 Kbps 



ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

 Access Point 

• ใช้ในการเช่ือมต่อกบัเคร่ืองคอมพวิเตอร์กบั
ระบบเครือข่ายแบบไร้สาย (wireless) 

• Bandwidth 11/54 Mbps 



 Wireless Card 

 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

PCMCIA 

PCI for PC USB 

• ติดตั้งบนเคร่ืองคอมพวิเตอร์เพือ่เช่ือมต่อ
กบัระบบเครือข่ายแบบไร้สาย 
• Bandwidth 11/54 Mbps 



 สาย UTP (Unshielded Twisted Pair) 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

• ใช้ในการเช่ือมระหว่างเคร่ืองคอมพวิเตอร์
และ Ethernet Switch หรือ Hub 
• Bandwidth 10/100/1000 Mbps 

• ความเร็วในการเช่ือมต่อขึน้อยู่กบัการเข้า
หัวสาย และอุปกรณ์ทีใ่ช้ในการเช่ือมต่อ 
•ระยะทางในการเช่ือมต่อ < 100m  



 สาย UTP และหวั RJ-45 

 สาย UTP ทีใ่ชใ้น Ethernet Lan จะเขา้หวัแบบ RJ-45 

 ภายในสาย UTP จะมีสายทองแดงยอ่ยอกี 8 เสน้ โดยถกูจดักลุม่เป็นคู่ๆ  ท ัง้หมด 4 คู ่

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

RJ-45 UTP 



 การเขา้หวั RJ-45 มีได ้2 แบบ คอื 
 แบบ A (Standard 568A) มีการเรยีงสายจากซา้ยไปขวา ดงันี้   

 ขาว/เขียว 
 เขียว 

 ขาว/สม้ 

 น า้เงิน 

 ขาว/น า้เงิน 

 สม้ 

 ขาว/น า้ตาล 
 น า้ตาล 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 แบบ B (Standard 568B) เป็นแบบทีนิ่ยมใชก้นัมาก มีการเรยีงสายจากซา้ยไปขวา ดงัน้ี  
 ขาว/สม้ 

 สม้ 

 ขาวเขียว 

 น า้เงิน 

 ขาว/น า้เงิน 

 เขียว 

 ขาว/น า้ตาล 
 น า้ตาล 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 สาย UTP มี 2 แบบ ตามการเขา้หวั RJ-45 ดงัน้ี 

 สายตรง (UTP Straight Cable) เป็นสายทีใ่ชท้ ัว่ไป และพบมาก โดยใชใ้นการเชือ่มเครือ่งคอมพิวเตอร์
เขา้กบัอุปกรณเ์ครือขา่ยจ าพวก Hub และ Switch โดยการเขา้หวัทัง้ 2 ปลายจะเป็นแบบเดยีวกนั (A 
หรือ B ก็ได)้ 

 สายครอส (UTP Cross-over Cable) ใชใ้นการเชือ่มตอ่ระหวา่งเครื่องคอมพิวเตอร ์2 เครือ่งโดยตรง 
ไมผ่า่นอุปกรณป์ระเภท Hub และ Switch นอกจากน้ียงัใชเ้ชือ่มระหวา่งเครือ่งคอมพิวเตอร ์และ 
Router (ซึง่ถือวา่เป็นคอมพิวเตอรอ์กีรูปแบบหน่ึง) โดยการเขา้หวัทีป่ลายทัง้ 2 จะไมเ่หมือนกนั 
กลา่วคอื ปลายขา้งหน่ึงเขา้หวัแบบ A อกีปลายจะเขา้หวัแบบ B 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 สายตรง (UTP Straight Cable) 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 สายครอส (UTP Cross-over Cable) 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 วธิีการเขา้หวัสาย UTP 
 1. ปลอกทีหุ่ม้สายออกประมาณ 2-3 ซม. 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 2. เรยีงสายทัง้ 4 คูใ่หถ้กูตอ้งตามรูปแบบที่ตอ้งการ (A หรือ B) แลว้ตดัใหส้ายทุกเสน้ยาวเทา่กนั โดย
ใหย้าวออกจากที่หุม้สายประมาณ 1.7 ซม. 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 3. สอดสายทีจ่ดัเรยีงเรยีบรอ้ยแลว้ เขา้ไปยงัหวั RJ-45 โดยใสเ่ขา้ไปใหสุ้ด และแน่นแลว้จงึใชท้ีเ่ขา้หวั
สายหนีบ เพ่ือดนัใหเ้ขา้ที ่

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



 สาย STP (Shielded Twisted Pair) 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

„ คล้ายกบัสาย UTP แต่มชีนวน และตัวน า
หุ้ม จึงป้องกนัสัญญาณรบกวนได้ด ีนิยมใช้
แทนสาย UTP ในที่ๆ  มสัีญญาณรบกวนมาก 
เช่น โรงงานอุตสาหกรรม ฯลฯ 
„ มรีาคาแพงกว่าสาย UTP 
 



 สาย Fiber Optic 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์

„ ใช้ในการเช่ือมต่อระหว่างอุปกรณ์เครือข่าย 
„ Bandwidth 10/100/1000 Mbps 
„ ระยะทางในการเช่ือมต่อ500m – 2Km 
แล้วแต่ชนิดของสาย  



 รูปแบบการสง่ขอ้มูลภายในเครอืขา่ย  

  Duplex หมายความถึง ความสามารถรบัและสง่ขอ้มูลดว้ยอุปกรณช์ิ้นเดยีวกนั ซึง่แบง่ยอ่ย
ออกเป็น 2 ประเภท คอื 

 Half Duplex จะรบัและสง่ขอ้มูลได ้แตไ่มส่ามารถท าพรอ้มกนัได ้กลา่วคอื ถา้ฝ่ายหน่ึงสง่ขอ้มูล อกีฝ่าย
หน่ึงจะตอ้งเป็นฝ่ายรบั ไมส่ามารถสง่ไดจ้นกวา่อกีฝ่ายจะเลิกสง่ขอ้มูล และเปล่ียนมาเป็นฝ่ายรบั เหมือน

การใชว้ทิยุสือ่สาร ไดแ้ก ่Ethernet ประเภท 10BaseT (10Mbps) เป็นตน้ 

 Full Duplex สามารถรบัและสง่ขอ้มูลไปพรอ้มๆ กนัได ้เหมือนกนัการพูดคยุผา่นโทรศพัท ์ไดแ้ก ่Fast 
Ethernet (100Mbps) หรือ Gigabit Ethernet (1000Mbps) เป็นตน้ 

ระบบเครอืข่ายคอมพิวเตอร ์และอุปกรณเ์ครอืข่ายคอมพิวเตอร ์



ประเภทของระบบเครอืข่าย 

 

 



 ระบบเครอืขา่ยแบง่ออกเป็น 3 ประเภท ดงัน้ี 

 LAN (Local Area Network) 
WAN (Wide Area Network) 
MAN (Metropolitan Area Network) 

ประเภทของระบบเครอืข่าย 



LAN (Local Area Network) 

 การเชือ่มตอ่ระบบเครอืขา่ยทีเ่ครือ่งคอมพิวเตอรอ์ยูใ่นพ้ืนทีใ่กลก้นั เชน่ การเชือ่มตอ่ในตกึ

เดยีวกนั การเชือ่มตอ่ในมหาวทิยาลยั การเชือ่มตอ่ในหน่วยงานตา่งๆ โดยการเชือ่มตอ่

สามารถผา่นระบบ Ethernet, Fast Ethernet, FDDI, Token Ring  

ประเภทของระบบเครอืข่าย 



WAN (Wide Area Network) 
 การเชือ่มตอ่ Lan เขา้ดว้ยกนัในกรณีทีร่ะยะทางในการเชือ่มตอ่ระหวา่งวง Lan ทัง้สองหา่งกนั

มาก โดยการเชือ่มตอ่สามารถท าไดโ้ดยการใช ้ATM, DSL, ISDN อืน่ๆ แตก่ารเชือ่มตอ่จะมี
ความเร็วในการเชือ่มตอ่ต า่กวา่การเชือ่มตอ่แบบ Lan 

ประเภทของระบบเครอืข่าย 



Man (Metropolitan Area Network) 
 เป็นการเชือ่มตอ่เครอืขา่ยคอมพิวเตอรบ์นพ้ืนทีข่นาดใหญเ่ชน่เดยีวกบั Wan แตก่ารเชือ่มตอ่

นัน้ จะเป็นการเชือ่มตอ่ดว้ยความเร็วสงู เชน่เดยีวกบัการเชือ่มตอ่แบบ Lan 
 

ประเภทของระบบเครอืข่าย 



 Ethernet/Fast Ethernet/Gigabit Ethernet Lan 

 Wireless Lan 

เทคโนโลยใีนการเชือ่มตอ่เครอืขา่ย 



Ethernet 
 การเชือ่มตอ่ทีใ่ชใ้นการเชือ่มตอ่ระบบ LAN ในปัจจบุนั โดยมีอตัรารบัสง่ขอ้มูลสงูสุดถึง 

10Gbps โดยเชือ่มตอ่ผา่นสาย UTP หรอื สาย Fiber optic 

เทคโนโลยใีนการเชือ่มตอ่เครอืขา่ย 



เทคโนโลยใีนการเชือ่มตอ่เครอืขา่ย 

 รูปแบบการเชือ่มตอ่แบบ Ethernet 

ชนิด ระยะทางสูงสุด ชนิดของสาย ความเร็ว 

10BaseT 100 m UTP 10 Mbps 

100BaseTX 100 m UTP 100 Mbps 

100BaseFX 400 m (half duplex) 

2000 m (full duplex) 
Fiber Optic 100 Mbps 

1000BaseSX 220 m Fiber Optic 
(MMF) 

1000 Mbps 

1000BaseLX 3-10 Km Fiber Optic 
(SMF) 

1000 Mbps 
 



เทคโนโลยใีนการเชือ่มตอ่เครอืขา่ย 

 ตวัอยา่งอุปกรณ ์Ethernet 

UTP Ethernet Card Fiber Optic 



Wireless Lan 

 รูปแบบการเชือ่มตอ่ระบบเครอืขา่ยผา่นคล่ืนวทิยุ โดยใชค้ล่ืนความถ่ีทีจ่ดัไวส้ าหรบัระบบ

อุตสาหกรรม วทิยาศาสตรแ์ละการแพทย ์(ISM band)  

เทคโนโลยใีนการเชือ่มตอ่เครอืขา่ย 



 มาตรฐานการใชง้าน Wireless ในประเทศไทย 

 IEEE 802.11 b 
Bandwidth 11 Mb/s 
 ระยะทางในทีโ่ลง่ 100 m. 

 IEEE 802.11 g 
Bandwidth 54 Mb/s 
 ระยะทางในทีโ่ลง่ 50 m. 

 

เทคโนโลยใีนการเชือ่มตอ่เครอืขา่ย 



เทคโนโลยใีนการเชือ่มตอ่เครอืขา่ย 

 วธีิการเช่ือมต่อเครือข่ายไร้สาย 

 การเชือ่มตอ่แบบแอดฮอค (Ad-Hoc) คอื การเชือ่มตอ่
ระหวา่งอุปกรณส์องตวัขึ้นไปโดยไม่จ าเป็นตอ้งใช ้Access 
Point 



 การเชือ่มตอ่แบบเป็นโครงสรา้ง คอื การตดิตอ่สือ่สารโดยมีสถานี

ฐาน (Access Point) เป็นศูนยก์ลาง โดยแตล่ะเครือ่งสามารถ
เชือ่มตอ่สูเ่ครอืข่ายภายนอกไดผ้า่นทาง Access Point  

เทคโนโลยใีนการเชือ่มตอ่เครอืขา่ย 



รูปแบบของระบบเครอืข่าย 

 

 



Mesh 
 Bus 
 Star 
 Tree  
 Ring 

รูปแบบของระบบเครอืข่าย 

http://en.wikipedia.org/wiki/Image:NetworkTopologies.png


ระบบเครอืข่ายรูปแบบ Mesh 

 

(Full Mesh) 

http://en.wikipedia.org/wiki/Image:NetworkTopologies.png
http://en.wikipedia.org/wiki/Image:NetworkTopologies.png


 ขอ้ด ี

 ในกรณีสายเคเบิ้ลบางสายช ารุด เครอืขา่ยทัง้หมดยงัสามารถใชไ้ด ้ท าใหร้ะบบ

มีเสถียรภาพสูง นิยมใชก้บัเครอืขา่ยทีต่อ้งการเสถียรภาพสูง และเครอืขา่ยทีมี่

ความส าคญั 

 ขอ้เสยี 

 สิ้นเปลืองคา่ใชจ้า่ย และสายเคเบ้ิลมากกวา่การตอ่แบบอืน่ๆ 

 ยากตอ่การตดิตัง้ เดนิสาย เคล่ือนยา้ยปรบัเปล่ียน และบ ารุงรกัษาระบบ

เครอืขา่ย  

ระบบเครอืข่ายรูปแบบ Mesh 



ระบบเครอืข่ายรูปแบบ Bus 

http://en.wikipedia.org/wiki/Image:NetworkTopologies.png


 ขอ้ด ี
 งา่ยตอ่การน าอุปกรณเ์ชือ่มตอ่เขา้กบัระบบเครอืขา่ย 

 ใชส้ายเคเบิลนอ้ยกวา่การตอ่แบบ Star 

 ขอ้เสยี 

 ระบบเครอืขา่ยทัง้หมดจะไมส่ามารถใชก้ารได ้ถา้สายหลกัช ารุด 

 จ าเป็นตอ้งมี Terminator ทีป่ลายทัง้ 2 ขา้งของสายหลกั เพ่ือป้องกนัสญัญาณ
สะทอ้นกลบัไปมาภายในสาย 

 คน้หาจดุทีเ่กิดปัญหาไดย้าก ถา้ระบบเครอืขา่ยทัง้หมดไมส่ามารถใชก้ารได ้

ระบบเครอืข่ายรูปแบบ Bus 



ระบบเครอืข่ายรูปแบบ Star 

http://en.wikipedia.org/wiki/Image:NetworkTopologies.png


 ขอ้ด ี
 งา่ยตอ่การตอ่อุปกรณแ์ละการเดนิสาย 

 สามารถเพ่ิมเตมิอุปกรณ ์หรอืถอดอุปกรณอ์อกไดง้า่ย และไมร่บกวนสว่นอืน่ 

 งา่ยตอ่การตรวจสอบจดุทีเ่กิดปัญหา และการแยกอุปกรณบ์างสว่นออกจากระบบ 

 ขอ้เสยี 

 เปลืองสายเคเบ้ิลมากกวา่การตอ่แบบ Bus 
 ถา้ hub หรือ switch ทีเ่ชือ่มอยูต่รงกลางมีปัญหา จะท าใหร้ะบบเครอืขา่ยทัง้หมดมีปัญหา
ไปดว้ย 

 คา่ใชจ้า่ยสูงกวา่การตอ่แบบ Bus เน่ืองจากจ าเป็นตอ้งมี Hub หรอื Switch เชือ่มตรงกลาง 

ระบบเครอืข่ายรูปแบบ Star 



 เป็นการผสมผสานกนัระหวา่งการตอ่

แบบ Bus และ Star หรือเป็นการ
ตอ่ Star ซอ้นกนัหลายชัน้ 

ระบบเครอืข่ายรูปแบบ Tree 

http://en.wikipedia.org/wiki/Image:NetworkTopologies.png


 ขอ้ด ี
 ในแตล่ะสว่นยอ่ยๆ จะตอ่ถึงกนัแบบ Star ท าไดร้บัขอ้ดีของการตอ่แบบ Star 
มาดว้ย 

 ขอ้เสยี 

 ระยะทางในแตล่ะสว่นยอ่ยๆ จะถูกจ ากดัโดยชนิดของสาย 

 ถา้สายหลกัหรอื Hub ตวักลางหลกัเสยี ระบบเครอืขา่ยทัง้หมดจะไมส่ามารถ
ใชก้ารได ้

 ยากตอ่การติดตัง้และเดนิสาย 

ระบบเครอืข่ายรูปแบบ Tree 



ระบบเครอืข่ายรูปแบบ Ring 

http://en.wikipedia.org/wiki/Image:NetworkTopologies.png


 ขอ้ดขีองระบบเครอืข่ายรปูแบบ Ring 

 การเพ่ิมเตมิขนาดของระบบเครอืขา่ย สง่ผลตอ่ประสทิธิภาพไมม่าก 

 ลดจ านวนตวัรบัและสง่สญัญาณลงครึง่นึง (ในกรณี Ring ทางเดยีว) 
 ทุกๆ อุปกรณท์ีเ่ชือ่มตอ่จะชว่ยขยายสญัญาณ ท าใหส้ามารถตอ่เป็นวงใหญไ่ด ้

 ขอ้เสยีของระบบเครอืข่ายรปูแบบ Ring 

 ประสทิธิภาพต า่กวา่แบบอืน่ เน่ืองจากตอ้งผา่นอุปกรณห์ลายตวั 

 ถา้อุปกรณบ์างตวัหรือสายเคเบ้ิลช ารุด จะท าใหเ้ครอืขา่ยทัง้หมดไมส่ามารถใช ้

การได ้(ในกรณี Ring ทางเดยีว) 

ระบบเครอืข่ายรูปแบบ Ring 



วธีิการตัง้คา่เครือ่งคอมพิวเตอรเ์พ่ือการใชง้านระบบเครอืข่ายอยา่งปลอดภยั 

 

 



 การตัง้คา่ IP Address บนเครือ่ง 
 Automatic  

 ง่ายในการใชง้าน และสะดวกในการดูแล 

 จ าเป็นตอ้งมี DHCP Server ในระบบ 

 Static 
 จ าเป็นตอ้งมีความรูเ้รื่อง IP Address 
 ไมจ่ าเป็นตอ้งตดิตัง้ DHCP Server ในระบบ 

วธีิการตัง้คา่เครือ่งคอมพิวเตอรเ์พ่ือการใชง้านระบบเครอืข่ายอยา่งปลอดภยั 



 การตัง้คา่ Windows Update 
 ชว่ยป้องกนัการโจมตจีากไวรสัหรือเวริม์ตา่งๆ 

 ชว่ย Update Driver ส าหรบัอุปกรณใ์หม่ๆ 

 เพ่ิมประสทิธิภาพการท างานของ Windows 

วธีิการตัง้คา่เครือ่งคอมพิวเตอรเ์พ่ือการใชง้านระบบเครอืข่ายอยา่งปลอดภยั 



 การตดิตัง้โปรแกรม Ad-aware 
  Ad-aware เป็นโปรแกรมทีช่ว่ยตรวจสอบวา่มีการตดิตัง้โฆษณาทีไ่มต่อ้งการลงบน

เครือ่งคอมพิวเตอรข์องเราหรอืไม ่หรอืโปรแกรมทีต่ดิตัง้ Toolbar ทีมี่ link ไปยงัเวบ็ไซต์
ตา่งๆ บนเครือ่งคอมพิวเตอรข์องเรา  

วธีิการตัง้คา่เครือ่งคอมพิวเตอรเ์พ่ือการใชง้านระบบเครอืข่ายอยา่งปลอดภยั 



การตรวจสอบระบบเครือข่ายเบื้องตน้ 

 

 



การตรวจสอบระบบเครือข่ายเบื้องตน้ 

 การตรวจสอบการเชือ่มตอ่กบัระบบเครอืขา่ย 

 

มกีารเช่ือมต่อระบบเครือข่าย ไม่มกีารเช่ือมต่อกบัระบบเครือข่าย 



การตรวจสอบระบบเครือข่ายเบื้องตน้ 

 การตรวจสอบ IP Address ของเครือ่งคอมพิวเตอร ์

1. ดบัเบิลคล๊ิกที ่           จะเกิดหนา้ตา่งดงัรูป 



การตรวจสอบระบบเครือข่ายเบื้องตน้ 

 การตรวจสอบ IP Address ของเครือ่งคอมพิวเตอร ์

2. คล๊ิกที ่“Support”  

 



การตรวจสอบระบบเครือข่ายเบื้องตน้ 

 กรณีทีไ่มไ่ด ้IP Address  



 การตรวจสอบระบบเครอืขา่ยดว้ยค าสัง่ตา่งๆ 

 Ping -> ใชใ้นการตรวจสอบการเชือ่มตอ่ระหวา่งโฮสต ์

 Nslookup -> ใชใ้นการตรวจสอบชือ่โดเมน 

 Traceroute -> ใชใ้นการตรวจสอบเสน้ทางในการเชือ่มตอ่ 

 

การตรวจสอบระบบเครือขา่ยเบื้องตน้ 



การตรวจสอบระบบเครือข่ายเบื้องตน้ 

 ขัน้ตอนในการใชค้ าส ัง่ 

 Start Menu -> Run 



การตรวจสอบระบบเครือข่ายเบื้องตน้ 

 ขัน้ตอนในการใชค้ าส ัง่ 

 พิมพ ์cmd 



การตรวจสอบระบบเครือข่ายเบื้องตน้ 

 ขัน้ตอนในการใชค้ าส ัง่ 

 



การตรวจสอบระบบเครือข่ายเบื้องตน้ 

 Ping 
 Ping IP address ทีต่อ้งการทดสอบ Ex ping 158.108.1.1 

  



การตรวจสอบระบบเครือข่ายเบื้องตน้ 

 Traceroute 
 Tracert IP Address ทีต่อ้งการ Ex tracert 158.108.50.5 



การตรวจสอบระบบเครือข่ายเบื้องตน้ 

 Nslookup 

 Nslookup ชือ่ทีต่อ้งการตรวจสอบ Ex nslookup www.google.com 



การตดิตัง้ Modem และการเชือ่มตอ่ Internet 

 

 



 Modem 

  โมเด็มคอื อุปกรณท์ีใ่ชใ้นการเชือ่มตอ่ระบบเครอืขา่ยผา่นทางสายโทรศพัท ์โดยมี

ความเร็วสงูสุดในการใชง้าน 56 Kbps 

การตดิตัง้ Modem และการเชือ่มตอ่ Internet 

Internal Modem External Modem 



การตดิตัง้ Modem และการเชือ่มตอ่ Internet 

 การเชือ่มตอ่ระบบเครอืขา่ยผา่น Modem 
 Start Menu -> Control Panel 

 

 เลือก Network Connections 

 

 เลือก Create a new Connection 



การตดิตัง้ Modem และการเชือ่มตอ่ Internet 

 เลือก Next 



การตดิตัง้ Modem และการเชือ่มตอ่ Internet 

 เลือก Connect to Internet แลว้คลิก Next 



การตดิตัง้ Modem และการเชือ่มตอ่ Internet 

 เลือก Setup my connection manually แลว้คลิก Next 



การตดิตัง้ Modem และการเชือ่มตอ่ Internet 

 เลือก Connect using dial-up modem แลว้คลิก Next 



การตดิตัง้ Modem และการเชือ่มตอ่ Internet 

 ใสช่ือ่ ISP แลว้คลิก Next 



การตดิตัง้ Modem และการเชือ่มตอ่ Internet 

 ใสห่มายเลขโทรศพัทแ์ลว้คลิก Next (ในกรณีทีต่อ้งมีการกดหมายเลขเพ่ือตดัก่อน ใหใ้สห่มายเลข
แลว้ตามดว้ยเครือ่งหมาย , ) 

 



การตดิตัง้ Modem และการเชือ่มตอ่ Internet 

 เลือก Add shortcut to this connection to my desktop แลว้คลิก Finish 



การตดิตัง้ Modem และการเชือ่มตอ่ Internet 

 ใส ่username กบั password แลว้คลิก Dial เพ่ือเชือ่มตอ่ Internet 



การใชง้าน และปรบัแตง่ Internet Explorer 

 

 



การใชง้าน และปรบัแตง่ Internet Explorer 

การยกเลิกการใช ้Proxy ใน IE 

 บางคร้ังการตั้งค่า Proxy ท าใหก้ารใชง้านอินเตอร์เน็ตชา้ หรือไม่สามารถ
ใชไ้ด ้

 เลือกเมนู Tools > Internet Options… 

1 

2 



การใชง้าน และปรบัแตง่ Internet Explorer 

 เลือกแทป็ Connections > LAN Settings… 

3 

4 



การใชง้าน และปรบัแตง่ Internet Explorer 

 ตรวจสอบวา่ หนา้ Option 
“Use a proxy server for your 
LAN(…)” มีเคร่ืองหมายถกู 
ใหค้ลิกเอาออก แลว้กด OK 
และ OK อีกคร้ัง 

5 

6 

7 



การใชง้าน และปรบัแตง่ Internet Explorer 

การยกเลิกการท างานของฟังกช์ัน่ Work Offline 

 ฟังกช์ัน่น้ีจะท าใหส้ามารถดูเวบ็ท่ีเคยดูมาแลว้ไดอี้ก โดยไม่ตอ้งเช่ือมต่อ
อินเตอร์เน็ต แต่ถา้เราเช่ือมต่ออินเตอร์เน็ตอยูแ่ลว้ ฟังกช์ัน่น้ีอาจท าใหไ้ม่
สามารถเขา้บางเวบ็ได ้หรือเห็นเวบ็เพจบางเวบ็ไม่อพัเดท (เห็นหนา้ตา
หรือเน้ือหาของเวบ็บางเวบ็เป็นหนา้ตาเดิมท่ีปัจจุบนัเปล่ียนไปแลว้หรือ
เน้ือหาเก่า ไม่เป็นปัจจุบนั) 



การใชง้าน และปรบัแตง่ Internet Explorer 

การยกเลิกฟังกช์ัน่ Work Offline 

 เลือกเมนู File > Work Offline ใหต้รวจสอบดูวา่ มีเคร่ืองหมายถกูหนา้ 
Option น้ีหรือไม่ ถา้มีใหค้ลิก 1 คร้ังเพ่ือเอาออก 

1 

2 



การใชง้าน และปรบัแตง่ Internet Explorer 

การจดบนัทึกท่ีอยูเ่วบ็ไซต ์

 ฟังกช์ัน่น้ีจะช่วยใหเ้ราจดเวบ็ท่ีเราสนใจ และตอ้งการจะมาเยีย่มชมอีกคร้ัง
ไวไ้ดอ้ยา่งง่ายดาย โดยไม่จ าเป็นตอ้งจ าท่ีอยูข่องเวบ็ไซตด์งักล่าว 

 สามารถแบ่งเป็นหมวดหมู่ตามตอ้งการได ้



การใชง้าน และปรบัแตง่ Internet Explorer 

การจดบนัทึกท่ีอยูเ่วบ็ไซต ์

 Favorites > Add to Favorites … 
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การใชง้าน และปรบัแตง่ Internet Explorer 

 ตั้งช่ือใหเ้วบ็ไซตใ์หม่เอง หรือใชช่ื้อเดิม แลว้กด OK ถา้ตอ้งการบนัทึกท่ี
อยูข่องเวบ็ไซตน้ี์ไวต้ามปกติ 

 ถา้ตอ้งการเยีย่มชมเวบ็ไซตท่ี์บนัทึกไวแ้ลว้อีกคร้ัง สามารถท าไดโ้ดย เลือก
เมนู Favorites > ช่ือเวบ็ไซตท่ี์ตอ้งการ 
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การใชง้าน และปรบัแตง่ Internet Explorer 

 ถา้ตอ้งการบนัทึกท่ีอยูเ่วบ็ไซต ์โดยเกบ็ไวใ้นหมวดหมู่ท่ีตอ้งการสามารถ
ท าได ้โดยขณะท่ีจะท าการบนัทึกท่ีอยูข่องเวบ็ไซตใ์ดๆ ใหค้ลิกท่ี Create 
in >> เพ่ือจดัประเภทเวบ็ไซตด์งักล่าวลงหมวดหมู่ท่ีตอ้งการ 
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การใชง้าน และปรบัแตง่ Internet Explorer 

 คลิกท่ีประเภทท่ีตอ้งการใส่ท่ีอยูเ่วบ็ไซตน้ี์ลงไป แลว้กด OK 
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การใชง้าน และปรบัแตง่ Internet Explorer 

 ถา้ตอ้งการสร้างหมวดหมู่หรือประเภทใหม่ สามารถท าไดโ้ดยคลิกท่ี
โฟลเดอร์ท่ีตอ้งการสร้างหมวดหมู่ยอ่ย แลว้คลิกท่ี New Folder… แทน 
หลงัจากนั้นใส่ช่ือหมวดหมู่ท่ีตอ้งการสร้างลงไป แลว้กด OK 

5 
6 
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การใชง้าน และปรบัแตง่ Internet Explorer 

 จะปรากฏหมวดหมู่ใหม่ท่ีเราสร้างข้ึนมา ถา้ตอ้งการบนัทึกท่ีอยูเ่วบ็ไซต์
ในหมวดหมู่ใด ใหค้ลิกท่ีหมวดหมู่นั้น แลว้คลิก OK 
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การใชง้าน และปรบัแตง่ Internet Explorer 

การจดัการบนัทึกท่ีอยูเ่วบ็ไซต ์

 Favorites > Organize Favorites… 

1 
2 



การใชง้าน และปรบัแตง่ Internet Explorer 

 สร้างหมวดหมู่ใหม่ สามารถท าไดโ้ดยเลือก หมวดหมู่ท่ีตอ้งการสร้าง
หมวดหมู่ยอ่ย แลว้คลิก Create Folder จะเกิดหมวดหมู่ยอ่ยภายใน ใหท้ า
การตั้งช่ือ 

3 
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การใชง้าน และปรบัแตง่ Internet Explorer 

 แต่ถา้ตอ้งการสร้างหมวดหมู่หลกั(ไม่อยูภ่ายในหมวดหมู่อ่ืนๆ) ท าไดโ้ดย
ไม่ตอ้งคลิกเพ่ือขยายหมวดหมู่ใด หรือคลิกท่ีบนัทึกท่ีอยูอ่ื่นๆ กไ็ด ้แลว้
คลิกท่ี Create Folder เลย 

3 
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การใชง้าน และปรบัแตง่ Internet Explorer 

 ลบหมวดหมู่หรือบนัทึกท่ีอยูไ่ดโ้ดย คลิกท่ีหมวดหมู่หรือบนัทึกท่ีอยูท่ี่
ตอ้งการลบ แลว้กดปุ่ม Delete หรือกดแป้นพิมพ ์Del 

1 
2 
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การอา่นเมลน์นทรดีว้ย Outlook Express 

 

 



การอา่นเมลน์นทรดีว้ย Outlook Express 

การตั้งค่าใน Outlook Express ส าหรับเมลน์นทรี 

  Start Menu > All Programs > Outlook Express 

1 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

 Tools > Accounts… 

3 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

 เลือก Tab Mail แลว้คลิกท่ีปุ่ม Add > Mail… 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

 กรอกช่ือท่ีตอ้งการใหผู้ท่ี้รับเมลเ์ห็นเวลาอ่านเมลท่ี์เราส่งไปให ้แลว้เลือก Next 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

 กรอกช่ือท่ีตอ้งการใหผู้ท่ี้รับเมลเ์ห็นเวลาอ่านเมลท่ี์เราส่งไปให ้แลว้เลือก Next 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

 เลือก mail server เป็นประเภท POP3 แลว้ใส่ Incoming mail server และ 
Outgoing mail server เป็น “mail.ku.ac.th”แลว้เลือก Next 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

 ใส่ช่ืออีเมลแ์อคเคานท ์ในกรณีตอ้งการใหจ้ ารหสัผา่น ใหค้ลิกเคร่ืองหมายถกู
หนา้ Remember Password จะท าใหไ้ม่ตอ้งกรอกรหสัผา่นทุกคร้ังท่ีตรวจสอบ
อีเมล ์
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การอา่นเมลน์นทรีดว้ย Outlook Express 

 เสร็จส้ินการติดตั้งอีเมลน์นทรี ส าหรับ Outlook Express แลว้เลือก Finish 

19 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 ถา้ท่านไดท้ าถกูตอ้งทุกข้ึนตอน จะพบแอคเคานทข์องนนทรีปรากฏอยู ่เสร็จ
แลว้เลือก Close เพ่ือส้ินสุดขั้นตอน 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

การตรวจสอบอีเมลใ์หม่ และการอ่านอีเมล ์

 คลิกท่ีปุ่ม Send/Recv จะเป็นการตรวจสอบอีเมลใ์หม่ทุกแอคเคานตท่ี์มี 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

 รอใหโ้ปรแกรมท าการดาวน์โหลดอีเมลท์ั้งหมดมาไวท่ี้เคร่ืองจนเสร็จ 

10 

11 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 เม่ือโปรแกรมท าการดาวน์โหลดเสร็จแลว้ จะมีตวัเลขบอกวา่ มีอีเมลใ์หม่ก่ีฉบบั 
คลิกท่ี Inbox เพ่ืออ่านอีเมลใ์หม่ดงักล่าว 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 คลิกท่ี Inbox > เลือกอีเมลท่ี์ตอ้งการอ่าน แลว้อีเมลฉ์บบันั้นกจ็ะปรากฏข้ึนมา 
ในคร้ังแรก อีเมลท่ี์มีภาพ ภาพจะไม่ถกูแสดงใหค้ลิกขอ้ความหมายเลข 4 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

 ภาพท่ีอยูใ่นอีเมลก์จ็ะถกูแสดงออกมา 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

 ภาพท่ีอยูใ่นอีเมลก์จ็ะถกูแสดงออกมา 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

การเขียนอีเมล ์

 คลิกท่ีปุ่ม Create Mail เพ่ือสร้างอีเมลใ์หม่ 

1 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 จะปรากฏหนา้ต่างเขียนอีเมลข้ึ์นมา ใหก้รอกขอ้มูลดงัต่อไปน้ี 

2 
3 

4 

„ ช่อง To: ใหก้รอกอีเมลข์องผูรั้บท่ีเราตอ้งการส่ง
อีเมล์ไปถึง สามารถกรอกมากกว่า 1 อีเมล์ไดโ้ดย
ใชเ้คร่ืองหมาย , คัน่ 

„ ช่อง Cc: จะคล้ายกับการส าเนาอีเมล์ฉบับ
เดียวกันน้ีมาส่งให้ผูรั้บในช่องน้ี โดยผูรั้บจะไม่
ทราบวา่อีเมลฉ์บบัน้ีส าเนาถึงใครบา้ง 

„ ช่อง Subject คือ ช่ือหวัขอ้ของอีเมล ์เพื่อบอกถึง
เน้ือความคร่าวๆ ของอีเมลฉ์บบัน้ี 

„ เขียนเน้ือความลงในพื้นท่ีวา่งดา้นล่างสุด 
5 

6 

แลว้ส่งโดยกด ปุ่ม Send 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 เม่ือการส่งอีเมลเ์รียบร้อยแลว้ อีเมลฉ์บบัดงักล่าวจะไปปรากฏท่ีโฟลเดอร์ Sent 
Items ของผูส่้ง แสดงวา่การส่งเสร็จสมบูรณ์แลว้ 

10 
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การอา่นเมลน์นทรีดว้ย Outlook Express 

การบลอ็คอีเมลจ์ากผูส่้งท่ีไม่ตอ้งการรับ 

 Tools > Message Rules > Blocked Sender List… 
1 

2 
3 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 คลิกท่ี Add… แลว้ใส่เบอร์อีเมล หรือโดเมนของอีเมล ์(เช่น hotmail.com, 
sanook.com) ท่ีตอ้งการบลอ็ก แลว้กด OK และ OK อีกคร้ัง 

4 

6 

7 

5 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 รายช่ืออีเมลท่ี์ท าการบลอ็กจะปรากฏข้ึน โดยสามารถท าการแกไ้ขไดโ้ดยกดปุ่ม 
Modify… หรือลบดว้ยการกดปุ่ม Remove หลงัจากนั้นกด OK เป็นขั้นสุดทา้ย 

8 

 ถา้ผูท่ี้ถกูบลอ็กส่ง
อีเมลลม์าถึงเรา 
Outlook จะน าเมลล์
ดงักล่าวไปใส่ไวใ้น
โฟลเดอร์ Deleted 
Items ใหท้นัที 



การอา่นเมลน์นทรีดว้ย Outlook Express 

การกรอกและจดัหมวดหมู่อีเมลท่ี์ไดรั้บ 

 Tools > Message Rules > Mail… 
1 

2 3 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 หลงัจากนั้นจะปรากฏหนา้ต่างข้ึนมาใหต้ั้งเง่ือนไขส าหรับกรอกและจดัหมวด 

4 

 ส่วนท่ี  1  จะเป็นการก าหนด
เ ง่ื อนขอ ง ท่ี อี เ ม ล์ ใ นก ลุ่ ม น้ี
จ าเป็นตอ้งมี (ถา้มีคุณสมบติัตรง
ตามเง่ือนไขก็จะถูกกระท าตาม
ท่ีตั้งไวใ้นส่วนท่ี 2) 

 ส่วนท่ี 2 จะก าหนดการกระท า
วา่เม่ืออีเมลมี์คุณสมบติัตามท่ีตั้ง
ไว ้จะจัดการหรือกระท าอะไร
กบัอีเมลเ์หล่านั้น 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 ส่วนท่ี  3  จะเป็นการก าหนด
รายละเอียดของเง่ือนไข และ
การกระท าท่ีตอ้งการใหท้ า  

 ส่วนท่ี 4 เป็นการตั้ งช่ือของกฎ
การกรองและการจดัหมวดหมู่ท่ี
เราสร้างข้ึนน้ี เพ่ือให้จ าไดว้่าตั้ง
เง่ือนไขและการกระท าอะไรไป
บา้ง 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 รายละเอียดของเง่ือนไขในส่วนท่ี 1 

 ถา้ตอ้งการใชเ้ง่ือนไขใดใหค้ลิกใหมี้เคร่ืองหมายถกูหนา้เง่ือนไขนั้นๆ 

 สามารถเลือกใชม้ากกวา่ 1 เง่ือนไขไดใ้น 1 กฎ 

 การปรับแต่งรายละเอียดของเง่ือนไขท่ีเราเลือก จะอยูใ่นส่วนท่ี 3 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 เง่ือนไขท่ีน่าสนใจในส่วนน้ี 

 Where the From line contains people  
เง่ือนไขน้ีจะใชเ้ลือกอีเมลจ์ากอีเมลข์องผูส่้ง เช่น ตอ้งการแยกเมลจ์าก 
boss@hotmail.com ออกจากเมลอ่ื์นๆ 

 Where the Subject line contains specific words  
เง่ือนไขน้ีจะพิจารณาวา่ หวัขอ้อีเมลท่ี์ไดรั้บมีค าท่ีเราก าหนดอยูห่รือไม่ 
เช่น เราตอ้งการคดัแยกอีเมลท่ี์มีค  าวา่ “ด่วน” ออกมาเป็นพิเศษ  

 Where the message body contains specific words  
เง่ือนไขน้ีจะพิจารณาวา่ เน้ือความของอีเมลมี์ขอ้ความท่ีเราก าหนดหรือไม่ 
เช่น ตอ้งการแยกอีเมลท่ี์มีเน้ือความเก่ียวกบับริษทั “บางกอก” ออกมา 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 Where the message size is more than size  
เง่ือนไขน้ี ช่วยใหเ้ราแยกอีเมลท่ี์มีขนาดเกินกวา่ท่ีเราก าหนดออกมาได ้
เช่น เราตอ้งการแยกเมลท่ี์มีขนาดใหญ่กวา่ 500 KB เพ่ือท่ีจะไดรี้บอ่าน 
และรีบลบ 

 Where the message has an attachment  
เง่ือนไขน้ีจะแยกอีเมลท่ี์มีการแนบไฟลม์าดว้ยออกจากอีเมลอ่ื์นๆ เช่น เรา
ตอ้งการยา้ยอีเมลท่ี์มีไฟลแ์นบมาดว้ยไปไวใ้นอีกโฟลเดอร์เฉพาะต่างหาก 

 For all messages 
ไม่มีการก าหนดเง่ือนไข แต่ครอบคลุมอีเมลทุ์กฉบบัท่ีไดรั้บ ใชส้ าหรับ
การกระท าท่ีตอ้งการกระท ากบัอีเมลทุ์กฉบบั เช่น การลบอีเมลจ์าก server 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 รายละเอียดของการกระท าในส่วนท่ี 2 

 จะมีผลต่ออีเมลทุ์กฉบบัท่ีมีคุณสมบติัตามเง่ือนไขท่ีก าหนดไวใ้นส่วนท่ี 1 

 สามารถเลือกใชม้ากกวา่ 1 การกระท าต่อ 1 กฎ 

 การปรับแต่งรายละเอียดของการกระท าท่ีเราเลือก จะอยูใ่นส่วนท่ี 3 
เช่นกนั 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 การกระท าท่ีน่าสนใจในส่วนน้ี 

 Move/Copy it to specified folder  
จะยา้ย/คดัลอก อีเมลไ์ปยงัโฟลเดอร์ท่ีเราก าหนด 

 Delete it 
จดัการลบท้ิง  

 Forward it to people 
ส่งอีเมลเ์หล่าน้ีต่อไปใหแ้ก่บุคคลท่ีเราก าหนด 

 Reply with message 
ตอบกลบัดว้ยอีเมลท่ี์เราเตรียมไวล่้วงหนา้ 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 Do not download from the server  
Outlook จะไม่ท าการดาวน์โหลดอีเมลเ์หล่าน้ีมายงัเคร่ืองของท่าน (จะเกบ็
ไวท่ี้ server ต่อไป) 

 Delete it from server 
จดัการลบออกจาก server (ปกติแลว้ อีเมลท่ี์ถกูโหลดมาจาก server จะไม่
ถกูลบ ดว้ยเหตุผลท่ีวา่ เพ่ือใหท่้านสามารถกลบัไปอ่านอีเมลท่ี์ลบออกจาก
เคร่ืองแลว้ แต่ยงัคงอยูท่ี่ server ได ้แต่การลบอีเมลอ์อกจาก server จะช่วย
ใหแ้อคเคานทข์องท่านเหลือท่ีวา่งมากข้ึน) 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 การก าหนดรายละเอียดของเง่ือนไขและการกระท าในส่วนท่ี 3 

 เป็นการก าหนดเง่ือนใหแ้ละการกระท าใหล้ะเอียด และเจาะจง เช่น ผูส่้งมี
ช่ืออะไร, อีเมลมี์ขนาดมากกวา่ก่ี KB, ยา้ยอีเมลไ์ปยงั Folder ใด ฯลฯ 

 รายละเอียดท่ีปรับแต่งไดจ้ะถกูขีดเส้นใต ้เม่ือตอ้งการก าหนดรายละเอียด 

 ถา้ก าหนดรายละเอียดไม่ครบจะไม่สามารถใชก้ฎได ้เพราะกฎตอ้งมีความ
ชดัเจน และสมบูรณ์ 



การอา่นเมลน์นทรีดว้ย Outlook Express 

 ตวัอยา่งการก าหนดรายละเอียด 

ก าหนดขนาดสูงสุดของอเีมล์ได้ในหน่วย KB 

ก าหนดเงือ่นไขว่า หัวข้อ
ของอเีมล์ต้องมีค าว่า 
“ส าคญั” หรือ “ด่วน” 

ระบุโฟลเดอร์ที่ต้องการย้ายอเีมล์ไปเกบ็ไว้ 

ระบุอเีมล์ที่ต้องการใช้ตอบกลบั 

เปลีย่นเป็น Or หรือ And ได้ 


